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Preface

Oracle Hospitality OPERA Reporting and Analytics is a web-based application that centralizes
hotel property management data to provide operational and analytical insights into business
operations, and to improve efficiency by delivering information to all roles within an enterprise.

Purpose

This document is intended for customers subscribed to Oracle Hospitality OPERA Reporting
and Analytics Cloud Services (OPERA R&A).

Audience

Oracle Hospitality OPERA Reporting and Analytics documentation applies to the following
users:

• • Application administrators who have permission to configure OPERA R&A.

• • Users who perform day-to-day reporting operations and typically do not have permissions
to configure OPERA R&A.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://iccp.custhelp.com/

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received

• Screen shots of each step you take

Documentation

Oracle Hospitality product documentation is available on the Oracle Help Center at http://
docs.oracle.com/en/industries/hospitality/.

Revision History

Table 1    Revision History

Date Description of Change

September 2024 Initial Publication.

Preface
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1
Reporting and Analytics for Hotels

Oracle Hospitality OPERA Reporting and Analytics is a web-based application that centralizes
hotel property management data to provide operational and analytical insights and to improve
efficiency by delivering information to all roles within an organization. Hotel organizations can
use Oracle Hospitality OPERA Reporting and Analytics Cloud Service to leverage data
management and business analytics functionality.

The following figure shows the most common tasks for OPERA Reporting and Analytics users.
Your business requirements and organization size ultimately determine how you use OPERA
Reporting and Analytics. For example, small organizations might have one person who
performs system administrator tasks as well as creates and publishes analysis reports.

 

 

 

 

Set up roles and permissions and add users Create analysis reports based on hotel subject
areas

Perform item alignment to ensure consistent
data for reporting

Analysis Report Examples: Hotels

Assign new property into enterprise reporting
hierarchy.

Hotel Report Tutorial: Regional Managers Property
Performance

Define currency exchange rules Dashboard Tutorial: Regional Metric Data and KPIs

Set up schedules for running reports and sending
them by email
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2
Common Actions and Navigation

Bookmark URL
The URL provided in the OPERA R&A welcome letter must be bookmarked by individual users
prior to accessing the login screen as there are automatic re-directs. Bookmarking after
connection will remove your tenant id which is needed for proper login.

Application Navigation

Figure 2-1    Example Application Header

• User Options: Exposes options to log off of the application or access help documentation.

• Navigation Menu: Expands the portlets menu, listing authorized portlets used to configure
the application
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Figure 2-2    Menu

• Menu: The primary application menu; based upon the permissions granted to your
group(s).

Search Options

Search options are presented on each portlet where searching for records is available.
Entering text into the field will present a list of records that match the value. This could be text
at any point in the front middle or end of the value. Select the value to choose the record.

Figure 2-3    Icons

Chapter 2
Application Navigation
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Drag and Drop

Moving records from one column or status to another can be done by selecting the record to
move by clicking and holding the mouse button down on the Move icon. Drag the record over
to the place to move and release the mouse button.

Application Tiles
Application Tiles provide quick access to identify and resolve any outstanding configuration
actions in OPERA R&A. Tiles are enabled through permissions.

Reporting Tiles

When the correct permissions are enabled, tiles for Reports, Dashboards, and Data Visualizers
are available on the home page. These tiles act as shortcuts to open these modules.

Configuration Tiles

When the correct permissions are enabled, tiles are available on the home page that will notify
the user of any outstanding configuration actions that may be required, based upon any new
definitions reported through OPERA or Identity Management. These tiles act as shortcuts to
open the individual configuration page and filter to show actionable records. Tiles are available
for Reporting Hierarchy, Groups, Users, and Central Currency Conversion.

Reporting Hierarchy:
This tile shows if any new levels or properties are defined and not assigned within the
reporting hierarchy. Until these are present in the reporting hierarchy, data for those
properties cannot be included in reporting.

Groups:
This tile shows groups that have been created that do not have any permissions granted.
Until permissions are defined for the group, any users associated with the group will not
have the ability to access functionality.

Users:
This tile shows users that have not been assigned a level in the Reporting Hierarchy or
chain(s). A level and chain(s) are required for the user to access reporting data.

Central Currency Conversion:
This tile shows if any central currency conversion rules are scheduled to expire within the
next 30 days.

Chapter 2
Application Tiles
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3
Controls

Controls allow for configuration of optional features and functionality in OPERA R&A.

Enable Central Currency Conversion
For an enterprise where properties with different base currencies are reporting, the central
currency conversion feature will provide date-based rules to manage the conversion of the
properties financial data. Property currency values are converted into a single central currency
reporting value selected once this functionality is enabled

1. From the OPERA R&A navigation menu, click Controls.

2. Enable the Enable Central Currency control.

Once Central Currency is enabled, it cannot be disabled.

1. When prompted, confirm or decline control restriction.

2. Select the currency to use for all enterprise reporting values. This value cannot be
changed once defined.

3. Click Save.

Reporting Links

Data Visualizer

The Data Visualizer URL can be copied and pasted to users who are reporting only users and
will need access to this reporting feature. The URL is not currently available from the OBI
Reporting Console and this URL can be bookmarked to provide the user access with valid user
permissions.

Smart View

The Smart View for Microsoft Office plug-in is available for download and installation from the
OBI Reporting Console. The URL provided is utilized to define the path users will enter while
configuring Smart View to gain access to any reporting data. Copy and paste to users that will
be permitted to access reporting data from the plug-in. Valid user authentication is required to
access the reporting data.

SFTP Configuration
Secure File Transfer Protocol (SFTP) allows reports to be delivered to a secure location
outside of the R&A system. This is useful when sharing data with third-party solution providers
or services. You may configure up to twenty five SFTP service profiles. Please review the
SFTP Guide in SFTP Service Configuration for details on configuring SFTP.

1. From OPERA R&A navigation menu, click Controls.
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2. Click the File Delivery, then SFTP tab.

a. If the SFTP tab is not present, an SFTP service is not configured for your organization.
Open an SR requesting your SFTP service be included as part of your R&A
organization.

3. Choose the SFTP Profile to update from the list, if more than one is defined.

4. Click the Update SFTP button to edit the SFTP fields.

5. Edit the remote directory for all reports to be exported (optional).

6. Enter your valid SFTP user and password (required).

7. Click Save.

Password Supported Characters

The SFTP password supports the following characters:

• The alphabetic characters a to z (uppercase and lowercase).

• The numerals 0 to 9.

• The following special characters:

Character Description

@ At sign

/ Forward slash

- Minus sign / Hyphen

. Period

_ Underscore

Resend

In the event of a failure during the SFTP transmission, you can configure the application to
automatically attempt to resend the failed delivery. Configuration of the resend functionality will
apply to all delivery profiles.

1. From the SFTP Tab, select Enable Resend on SFTP Delivery Failure.

Note:

Resend functionality requires the Service Account to be enabled.

2. You may optionally change the three (3) resend configuration parameters:

a. Retry Attempts – defines the number of times (ranging from 1 to 6) to retry failed SFTP
jobs according to the resend frequency.

b. Resend Frequency (Min) – defines in minutes how often the system wakes up to check
for and resend failed SFTP jobs.

c. Resend Duration (Min) – specifies the duration in minutes for which the system should
continue attempting to resend failed SFTP jobs.

3. Click Save.

Chapter 3
SFTP Configuration
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Object Storage
The Object Storage tab which provides information required in the use of Object Storage.

1. From the OPERA Reporting and Analytics navigation menu, click Controls

2. Click on the File Delivery, then Object Storage tab

a. If the Object Storage tab is not present, your OPERA Reporting and Analytics instance
is utilizing OBIEE for reporting services. Migration of OBIEE to OAS instances is
underway. Contact your account manager about having your migration scheduled if
you require this functionality sooner.

3. Choose the Object Storage tab

4. From the tab you can highlight and copy your AppID which is required to process any files
to Object Storage.

5. Click the Show/Hide button to expose the Object Storage Secret. This field can also be
highlighted and copied once visible.

6. You can optionally click the Regenerate Secret button to generate a new Object Storage
secret.

Set Upgrade Preference
The upgrade of your analytics version will now be scheduled based upon a preferred time.
Time is based upon your local time zone but recorded in UTC. By default, upgrades are
scheduled for 00:00 UTC. To change your preferred time, follow the instructions below.

1. From OPERA R&A navigation menu, click Controls.

2. Click on the System tab.

3. Edit the preferred time for upgrades to be performed, local time (optional).

4. Click Save .

Service Account
The Service Account is used to run applications, automated services, and background
processes in OPERA Reporting and Analytics. It is strongly recommended that this account be
associated to a dedicated, non-person user and email address to prevent any interruption in
service. A service account must be a privileged account that is associated with the OC_RNA-
BIADMIN Group. To enable the Service Account:

1. From OPERA Reporting and Analytics navigation menu, click Controls.

2. Click the System, then Service Account Tab.

3. From the list, select the dedicated, non-person user account. a. If the account does not
show in the list, please reconfirm that the account is associated with the OC_RNA-
BIADMIN group.

4. Enter the password for the Service Account.

5. Click the Validate button to confirm the user credentials can be accessed.

6. Click Save.

Chapter 3
Object Storage

3-3



Password Supported Characters

The password supports the following characters:

• The alphabetic characters a to z (uppercase and lowercase).

• The numerals 0 to 9.

• The following special characters:

Character Description

@ At sign

/ Forward slash

- Minus sign / Hyphen

. Period

_ Underscore

Chapter 3
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4
Enterprise Hierarchy

The enterprise hierarchy provides the reporting structure to an enterprise and its properties.

The enterprise has only a single hierarchy. The hierarchy ensures totals from all properties are
available for reports and controls how dashboards and other visualizations show information in
OPERA R&A.

The hierarchy consists of levels and properties. A property is a hotel. A level is a group of
levels or a group of properties. You define the hierarchy by creating parent-child relationships
between levels and properties. In the following figure of a sample hierarchy, District 1 is the
parent to the Property A and Property B, and Region A is the parent to District 1 and District 2.

The enterprise hierarchy is utilized to determine user access to information in the application.
Using the sample hierarchy as a model, you can create a District Manager group and then
assign the role to Jen, the District Manager for District 1. Because of the relationship between
District 1 and the Properties A and B, Jen can see information for those properties only. She
cannot see information for the locations related to the other districts.

Create Level
1. From the OPERA R&A navigation menu, click Reporting Hierarchy.

2. Click Create Level.

3. Type a level code.
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4. Type a level name.

5. Optionally create a relationship to another level.

6. Click Save.

Note:

As a best practice, single property organizations should not create a reporting
hierarchy and assign their property directly to the organization level. Small chains
and large enterprises should carefully construct a hierarchy that will properly allow/
restrict access to property data.

Assigning Properties
OPERA properties are automatically synced to OPERA R&A as part of the provisioning
process completed by your Oracle Cloud Enablement team.

1. From the OPERA R&A navigation menu, click Reporting Hierarchy.

2. Locate the unassigned property from the Unassigned column.

3. Drag and Drop the property into the Assigned list to establish the parent-child relationship.

a. Properties can have a parent-child relationship with the Enterprise without a level by
dropping the property at the bottom of the list.

b. Properties are assigned to a level in the Enterprise Hierarchy by dropping the property
onto the level.

Note:

Assignment of a property to an existing level in the hierarchy will grant users
assigned that level in the hierarchy access to view property data.

Re-assigning Properties
OPERA properties can be moved from one level to another should the enterprise structure
change.

1. From the OPERA R&A navigation menu, click Reporting Hierarchy.

2. Locate the assigned property from the Assigned column.

3. Drag and Drop the property from the current level to the new level in the Enterprise.

a. Levels and all their relationships can also be re-assigned by moving the level.

Edit Level
1. From the OPERA R&A navigation menu, click Reporting Hierarchy.

2. From the Level, click Edit.

Chapter 4
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3. Edit a level code or name.

4. Click Save.

Delete Level
1. From the OPERA R&A navigation menu, click Reporting Hierarchy.

2. From the Level, click Delete.

a. Delete option will only be shown when no existing relationships to other levels or
properties are found

3. From confirmation prompt, click Confirm.

Chapter 4
Delete Level
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5
Groups, Tasks, and Users

OPERA R&A uses groups and tasks to control access to content and functionality. A group
defines a set of tasks for a user type, while the user tasks represents content or functionality.

The following figure illustrates a typical flow for configuring groups and users to OPERA R&A:

Figure : Group and User Configuration

OPERA Reporting and Analytics provides the following default groups:

OPERA R&A Application Administrator
This group provides access to every area of the enterprise configuration. User assigned to this
group can perform any action and make any change in the application portal. This group
provides no reporting capabilities. Changes to this read only group are not permitted. If
reporting tasks are required for these users, other default or generated groups with reporting
tasks must be associated with the user.

OPERA R&A Reporting Administrator
This group provides access to view enterprise configuration in addition to all supported
features and subject areas in the OBI Reporting Console (reporting tool). User assigned to this
group can view certain configuration in the application portal and utilize most all capabilities in
the reporting tool. For security purposes, the ability to view personally identifiable information
(PII) is restricted by default with this group. Changes to this group can be made through the
Group portal by an authorized user.

OPERA R&A Chain Administrator
Users assigned to this group are defined as Chain Administrators for any Chains that are
assigned to the User. This will permit them to manage those users within their assigned chains
as well as assign any unassigned users to their chain. By default, this group has no user tasks
granted. It is strongly recommended that tasks be defined based upon those needed for this
role in your organization.

Custom Groups
If the default groups do not meet your business requirements, you can create custom groups
and specify user tasks for any new groups. For example, your enterprise has a district level
with three districts. Each district has three properties. You can create a District Manager group.
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When you add a District Manager user, you assign the user to the district enterprise level and
to the new District Manager group. Because of the district-property relationship settings in
OPERA R&A, District Managers can view data for only the properties in their districts.

Note:

As a best practice, create custom groups to limit access to specific application and
reporting functionality based upon the user’s role in the enterprise. For instance,
users that are permitted to run reports, but not author/edit report should have a
custom group that will restrict their user tasks to only allow consumption of existing
reports.

Create Group
If utilizing OPERA Cloud Identity Management (OCIM) for user and group management,
please refer to the section on Managing Groups in the OCIM Administrator Guide. The latest
version release of OCIM documentation can be found here.

If utilizing Identity Access Management (IAM), these groups are used to grant access to
OPERA Reporting and Analytics portals and capabilities. Under the IAM, groups are the links
between user accounts and OPERA Reporting and Analytics. They contain tasks that you
grant to users. Only IAM Console users are permitted to create Groups.

1. From the Identity Domain console, select the Groups option from the menu.

2. Click Create Group.

3. In the Name and Description fields of the Create Group window, enter the name and
description about the group. The Group Name is required to begin with “OC_RNA-” in
order for the group to be configurable in OPERA Reporting and Analytics. Groups with any
other names will not be found or usable in the application.

Note:

Use of capitalized alphabet, numbers, and _ are allowable characters for the
Group Name. Use of lower case, other special characters or spaces is not
allowed.

4. Click Create.

Additional information on group configuration can be found at https://docs.oracle.com/en-us/
iaas/Content/Identity/groups/managinggroups.htm

Note:

Changing the name of a group once tasks have been assigned will invalidate the
groups reporting tasks and prevent users from accessing reporting functionality.

Set Group Tasks

Chapter 5
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From the OPERA R&A Groups portlet, individual groups created under IDCS will be listed and
available to have tasks defined. User Tasks are broken out by individual sub-categories. To
allow access to all user tasks within a sub-category, enable the sub-category. This will enable
all the individual tasks within the sub-category. To enable only specific user tasks, use the
enable/disable option to change the value.

1. From the OPERA R&A navigation menu, click Groups.

2. From the list or search bar, locate the Group to set user tasks.

3. Click Edit on the Group.

Set tasks within the categories listed below. For a detailed account of each user task, see
Appendix A.

1. Click Save.

Administration

The Administration category contains all of the available tasks for controlling access and
capabilities for configuring the application. Configuration capabilities encompass the entire
enterprise and cannot be restricted/configured to individual hubs, chains or properties.

Note:

Refer to the Appendix for a listing of all available user tasks and their function. Only
assign administration tasks that are needed to support the groups role in the
application portal.

Reporting

The Reporting category contains all of the available tasks to author, distribute and access data
Subject Areas. User tasks granted define the capabilities that users associated with this group
are permitted to use.

Note:

Refer to the Appendix for a listing of all available user tasks and their function. Only
assign reporting tasks that are needed to support the groups role in the reporting
module.

Group As Role
From the OPERA R&A Groups portlet, individual groups created under IDCS will be listed and
available to be defined as a Role in your reporting module. Enabling a group as a role allows
you to configure access to specific folders and catalog objects based upon the Role.

• From the OPERA R&A navigation menu, click Groups.

• From the list or search bar, locate the Group to edit.

• Click Edit on the Group.

• To enable, select the Update Group as Role option and click Save.

Chapter 5
Group As Role

5-3



– Once enabled and saved, role configuration will be pushed overnight and update the
reporting module.

• To disable, unselect the Update Group as Role option and click Save.

– Once disabled and saved, role configuration will be removed overnight and update the
reporting module. Any restrictions on reports for groups will be removed at this point.

Configure Role on Folder or Catalog Object

1. From the OPERA R&A navigation menu, click Reports and Dashboards.

2. From the BI Application locate and select the folder or catalog object to configure access.

3. Select More > Permissions.

4. Under Permissions, click the Add button.

5. Under the Available Members section, enter the name of the Role and click Search.

6. Select the Role and add to the Selected Members list using the move buttons.

7. Change the Set Permission value to match your desired outcome. Enable the Apply
permissions options accordingly and click OK.

Note:

Removal of the BI Content Consumer, BI Content Author or BI Administrator will
render the folder or catalog object inaccessible. Do not remove these.

Once configured, any user that has that role will have the configuration applied.

Create User/Assign Groups
If utilizing OPERA Cloud Identity Management (OCIM) for user and group management,
please refer to the section on Managing Users in the OCIM Administrator Guide. The latest
version release of OCIM documentation can be found here.

If utilizing Identity Access Management (IAM), users are defined and granted access to
OPERA R&A portals and capabilities through Group assignment in IAM. Only IAM Console
users are permitted to create other IAM and OPERA R&A users.

It is strongly recommended to have additional users defined as IAM Administrators to
allow for group and user creation in case of administrator absence or departure and to
avoid interruption in operations. In the event your IAM Administrator has departed, and
no alternative administrators are defined, open a non-technical service request with
Support requesting a new IAM Administrator.

1. From the Identity Domain console, select the Users option from the menu, and then click
Create User.

2. In the First Name and Last Name fields of the Create User window, enter the user’s first
and last name.

3. To have the user log in with their email address:

a. Leave the Use the email address as the user name check box selected.

b. In the User Name / Email field, enter the email address for the user account.

Chapter 5
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OR

1. To have the user log in with their user name:

a. Clear the Use the email address as the user name check box.

b. In the User Name field, enter the user name that the user is to use to log in.

c. In the Email field, enter the email address for the user account password recovery.

2. Under the Groups section, select the check box for each group that you want to assign to
the user account.

3. Click Create.

Additional information on user configuration can be found at https://docs.oracle.com/en-us/
iaas/Content/Identity/users/about-managing-users.htm

Set User Access
From the Users portlet, individual users created under IDCS will be listed and available to have
user tasks defined.

1. From the OPERA R&A navigation menu, click Users.

2. From the list or search bar, locate the User to define allowable property data.

3. Click Edit on the User.

4. Click Define Access

5. Define the access that will be available for the user to report on:

• All levels and Properties

• Individual Enterprise Level within the Reporting Hierarchy

• Individual property or multiple properties from the property list

• Combination of Enterprise Level and Property/Properties

6. Click Save.

7. Set the Chain(s) for the User. See description below.

8. Click Save.

Chains

For an enterprise that consists of multiple chains, the Chain assignment option will restrict the
user to only reporting data for properties defined for the selected chain(s) regardless of the
presence of other properties within their defined access.

When the user is defined as a Chain Administrator (Group), they will be given the ability to
manage user assignments within their assigned chains.

Note:

Note: Ensure all users have a defined access and chain associated to them prior to
accessing reports and dashboards to prevent any potential issues. If a user accesses
prior to adding these, once added, they will need to clear their cache or use a private
browsing window.

Chapter 5
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6
Central Reporting Conversion

Central Reporting Conversion is used to configure conversion values for the Property
Reporting Items from OPERA and Enterprise Reporting Items. Conversion is based upon the
individual Enterprise Reporting Types such as Chains, Markets and Room Classes.

Property Reporting Item alignment matches similar items under the Enterprise Reporting Item,
ensuring that reporting and calculations account for variances in naming or entry and that data
remains structured. The following diagram provides an overview of how reporting items can be
aligned.

Figure - Central Reporting

 

 

Reporting Item Types
The Reporting Item Types are different categories of definitions and dimensions in which your
property data is received and can be reported.

Enterprise Reporting Items

Create Enterprise Reporting Item

1. From the OPERA R&A navigation menu, click Central Reporting Conversion.

2. Click Create.

3. Select the enterprise reporting item type.

4. Enter a name.

5. Depending upon the type selected, additional required fields may be presented

6. Enter the PMS Reference
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7. Click Save.

Edit Enterprise Reporting Item

1. From the OPERA R&A navigation menu, click Central Reporting Conversion.

2. From the Reporting Item Type search, select the correct type for the Item to edit.

3. From the item, click Edit.

4. Edit a reference or name.

5. Click Save.

Delete Enterprise Reporting Item

1. From the OPERA R&A navigation menu, click Central Reporting Conversion.

2. From the Reporting Item Type search, select the correct type for the Item to edit.

Note:

Before an Enterprise Reporting Item can be deleted, any Property Reporting
Items must be unaligned. Either unalign or realign any Property Reporting Items
to allow for deletion.

3. From the item, click Edit.

4. Click Delete.

Property Reporting Items

Orphaned Reporting Items

When the Property Reporting Item is not aligned with an Enterprise Reporting Item, it is
considered to be “Orphaned”. Any measurables for these orphaned records are reported under
a Property Specific line item on the Enterprise Report.

Aligned Reporting Items

These are Property Reporting Items that are aligned with an Enterprise Reporting Item. All
measurables for these item will be included in the calculated value. Property Reporting Items
can be moved within Central Reporting Conversion by using the following actions:

Alignment Actions

Align Items

From the Unaligned list, you can quickly add all unaligned reporting items of a specific PMS
Reference Code to a newly defined Enterprise Reporting Item.

1. Create a new Enterprise Reporting item to containing the PMS Reference Code you wish
to align under the Reporting Item Type.

2. Click the Align Items button to align all property reporting items with that PMS Reference
Code to the new Enterprise Reporting Item.
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Align

1. From the Unaligned list, click and hold the Property Reporting Item to align.

2. Drag the item onto the Enterprise Reporting item to align

Unalign

1. From the Aligned list, click and hold the Property Reporting Item to unaligned.

2. Drag the item onto the Unaligned list

Realign Item

1. From the Aligned list, click and hold the Property Reporting Item to realign.

2. Drag the item onto another Enterprise Reporting Item

Realign All

To realign all property reporting items in an Enterprise Reporting Item.

1. From the Aligned list, click and hold the Enterprise Reporting Item to realign.

2. Drag onto another Enterprise Reporting Item.

3. All Property Reporting Items will be realigned to the new Enterprise Reporting Item.
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7
Central Currency Conversion

When Central Currency functionality has been enabled, access to the Central Currency
Conversion portlet is made available. Within this portlet, users and create sets of conversion
rules that are utilized to generate a central reporting value based upon buy rates specified at
the enterprise level.

Currency Rules
Currency Rules provide the required attributes for conversion of any property currency values
into the central currency values generated in the application.

Create Currency Rule

1. From the OPERA R&A navigation menu, click Central Currency Conversion.

2. Click Create.

3. Select the Property Currency to convert.

4. Set the Buy Rate for the conversion.

5. Specify the first business date that will utilize this rule

6. Optionally, set an expiration for the last business date to use this rule.

7. Click Save.

Edit Currency Rule

1. From the OPERA R&A navigation menu, click Central Currency Conversion.

2. From the Search Currency field, enter the currency to edit.

3. From the rule list, select the rule and click Edit.

4. Edit the buy rate or any of the dates.

5. Click Save.

6. Click Create.

7. Select the Property Currency to convert.

8. Set the Buy Rate for the conversion.

9. Specify the first business date that will utilize this rule

10. Optionally, set an expiration for the last business date to use this rule.

Click Save.
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8
Fiscal Period Reporting

Fiscal Period Reporting provides access to execute reports based upon configurable fiscal
periods. Within this portlet, users can create, edit, or delete fiscal period definitions. Once
definitions are available, certain reports can be made based upon a fiscal period.

How to Create a Fiscal Year
1. From the OPERA R&A navigation menu, click Fiscal Period Reporting.

2. Click Create.

3. Enter the Name of the fiscal year.

4. Specify the Start Date and End Date for the fiscal year.

5. Optionally, change the Fiscal Cycle to be based upon one if the pre-defined accounting
cycles.

a. Fiscal cycles define the number of weeks in each financial period in each financial
quarter. For example, the 4-4-5 accounting cycle means that in each quarter, the first
financial period consists of the first four weeks, the second period consists of the next
four weeks, and the third period consists if the next five weeks. This quarter then
accounts for 13 weeks, and the four quarters account for 52 weeks, or the full calendar
year.

6. Click save.

How to Edit a Fiscal Year
1. From the OPERA R&A navigation menu, click Fiscal Period Reporting.

2. Locate the current Fiscal Year to Edit and click the Edit icon.

3. Optionally edit the Name of the fiscal year.

4. Optionally edit the Start Date for the fiscal year.

5. Optionally edit the End Date for the fiscal year.

6. Optionally edit the Fiscal Cycle for the fiscal year.

7. Click Save.

How to Delete a Fiscal Year
1. From the OPERA R&A navigation menu, click Fiscal Period Reporting.

2. Locate the fiscal year to delete and click the Delete icon.

3. Confirmation of deletion will be displayed once completed.
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9
Application Change Log

The Application Change Log provides authorized users the ability to audit changes made to the
R&A application portal. To access the Application Change log, select the option from the menu
or through the application tile on the home page.

Search Application Change Log

1. Choose the Change Group to search.

2. Choose the Action Type to search for the selected Group.

3. Optionally select the User Login to search.

4. Specify the date range to search by using the Start and End date fields.

5. Click the search button.

Records matching the search criteria are presented in the log.

Records returned provide the description of the change, the old value, new value, datetime of
change, and the user that made the change.

Download Application Change Log

1. When records are available in the log, click the Download Logs button to generate a .csv
file containing the records.

9-1



10
End of Day Reporting

Authorized users in the Application Portal will have the ability to setup End-of-Day Reporting
configuration. This End-of-Day Reporting configuration allows for specific reports to be
scheduled for delivery when the property end-of-day (EOD) is identified from OPERA. These
reports include:

• Data Model-based BI Publisher Reports

– Only BI Publisher Reports that are based upon a data model, not a Subject Areas,
qualify for use during EOD.

– For BIP reports to work with EOD, add a p_resorts and p_business_date as
parameters in the Data Model.

• Analysis Reports

– For an analysis report to qualify for use during EOD, the report must have Property
and Business Date as prompts under filters. This allows the values passed by the
application to be ran.

End of Day Configuration

1. If Service Account is not enabled, enable at this time.

2. From the Navigation Menu, select End of Day Reporting.

3. From the End of Day Reporting page, enter the code of the property to view or use the
search option to pick from a list of properties.

4. Once entered, click the Search button to load any reports configured for the property.

5. Under the Reports register section will be any reports current scheduled to run at the end
of day.

Add a New Report

Allows you to add reports to the End-of Day reports register for a property.

1. Click the New button to add a new report.

2. Using the Search and Select Report window, locate the BI Publisher report to have
scheduled to run after EOD.

3. Highlight the report and click the Select button.

4. Under Select Destination, choose the destination for the Report to be distributed after the
EOD. There are 4 options to choose from For BI Publisher report:

a. Defined By Report: The Defined by Report option will utilize the destination(s)
preconfigured under the bursting query for this report.

b. Email: Email will prompt you to enter a single email address for delivery.

c. Object Storage: When selection Object Storage, you will be prompted to provide the
Prefix and File Name to use during delivery of the report. These are both case-
sensitive fields.
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d. SFTP: You must chose from one of the defined Delivery Profiles prior to setting the
Remote Directory and File Name to use for delivery.

5. Click Save to save the report delivery configuration. For Analysis Reports, e-mail is the
only available delivery destination

Repeat steps 1 through 5 for any additional reports to be delivered as part of the End of Day
Reporting for this property.

Clone Reports to Property

For use with multi-property instances. If reports defined from one property are also the same
needed for other properties, a clone feature has been made to copy existing reports register
from one property to others without having to recreate each report job.

1. Navigate to the Reports register for the property to clone.

2. Click the Clone to Property button to prompt for a list of Properties to select for replication
of the report jobs.

3. Select at least one property and click the Save button to clone these reports to the
selected properties.

Edit Property Report

In the case where you wish to change the destination of a report in the report registry for a
property, you can edit the report. After changing, the next time the report is scheduled it will go
to the new destination.

1. Navigate to the Reports register for the property to edit.

2. Click the Ellipses button on the report to expose the Edit Report option.

3. Select the Edit Report option.

4. Update the destination configuration of the report and click Save.

Delete Property Report

In the case where you wish to remove a report in the report registry for a property, you can
delete the report.

1. Navigate to the Reports register for the property to edit.

2. Click the Ellipses button on the report to expose the Delete Report option.

3. Select the Delete Report option to remove the report from the Report register.
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11
Analysis Reports

Analysis Reports enables you to design and maintain reports and visualizations of data posted
to OPERA Reporting and Analytics. Analysis reports are comprised of:

Table 11-1    Analysis Report Components

Analysis Report Component Example

Subject areas represent an
area of business data that end
users can view in the analysis
report, and consist of folders,
measure columns, attribute
columns, hierarchical columns,
and hierarchy levels.

The Statistics - Managers
Report subject area contains
operations data for guest,
revenue, room and rates.

Folders provide a named
grouping of columns.

The Statistics - managers
Report subject area contains
multiple folders. Folders will
contain attributes and
measurements based upon
each of the folders names.

Attribute columns hold a flat
list of values with no
hierarchical relationships, and
provide scope and constraints
to the data presented by a
report. The folders containing
attribute columns unique to
the selected subject area
typically contain
Definitions in their names.

the Calendar Period folder
contains attribute columns
such as Period Code and Year.

Hierarchical columns hold data
values that are organized using
named levels and parent-child
relationships. Hierarchical
columns enable users to drill
down into the data, and their
folder name typically contains
Hierarchy.

Some files may contain the
Calendar Year Hierarchy
column, which can drill down
into the All Years, Calendar
Year, Calendar Month, and
Business Date Detail columns.
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Table 11-1    (Cont.) Analysis Report Components

Analysis Report Component Example

Measure columns hold a list of
data values that typically
reside in the Business
Intelligence repository as a fact
table, which can change or be
added or aggregated. The
folders containing measure
columns typically contain
Measures in their names.

The Statistics-Managers Report
subject area contains folders
that contain measure columns
for items such as counts and
revenues..

You can select the operational subject area, or business model, that applies to the report or
visualization you want to view or create, and then you can apply business analytics by:

• Selecting specific data sets to use in the report, and then applying filters to each data set.

• Selecting and configuring the resulting appearance of data, such as by rearranging
columns and rows in the table, inserting visualizations and charts, and changing column
labels.

• Adding and configuring user prompts to enable users viewing the report to configure data
filters as needed. For example, you can add a date selection prompt to allow users to set
the range of dates for which they need the report.

Online help opens if you access Help when creating or editing analysis reports or when
working with dashboards. The online Help may describe functionality not available in OPERA
R&A.

Sharing Analysis/Visualizer Reports
Analysis Reports enforce file permissions by restricting access to the My Folder for each user
account and to the Shared Folder:

• Only the specific user can view and access the contents of their My Folder.

• All users can view the content of the Shared Folder but cannot enact changes.

Deleting a report in your My Folder does not impact the copy of the report in the Shared Folder.

1. In OPERA R&A, to access reporting if you cannot access the reporting link, contact your
system Administrator.

2. To save an analysis report to the Shared Folder or to change the users and roles for which
the report is saved:

a. Select the report for which you want to configure permissions, and then click the report
properties and then permissions.

b. Select whether to configure permissions for the report at the Roles level or at the
individual Users level.

You cannot configure a report to have both role-level and user-level permissions. For example,
if you configure role-based permissions for a report, and then configure user-based
permissions, the user-based permissions overwrite the role-based permissions.

Use the lists and arrows to add or remove permissions, and then click Save.
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Analysis Report Examples
The following analysis reports provide examples of how you can leverage and implement
analysis reports to solve business information needs.

Corporate Revenue Manager

The Corporate Revenue Manager wants to view a comparison of sales across all properties in
different regions and a comparison of sales at the district and location levels. You can create a
report that allows the user to drill down the organizational levels and to view yearly sales and
revenue information, including key performance indicators such as Average Daily Revenue and
Revenue Per Available Room.

Regional Hotel Manager

The Regional Hotel Manager wants to identify the most and least profitable properties as well
as positive and negative sales and cost outliers. You can create a report that allows the user to
quickly view the performance of properties across the region and identify the most and least
profitable properties. The user can then view key revenue metrics such as average daily rate
(ADR) and revenue per available room (revPAR) to identify potential opportunities for
improvement.

Property General Manager

The Property Manager wants to identify the market segment and channel that are driving the
booking and focus on segment to market. You can create a report that shows property the
average guest expenditure and ADR by room type. This allows the Property Manager to
monitor performance and revenue by market mix and to identify both the areas needing focus
and the areas with the most potential.

Hotel Operations Manager

The Hotel Operations Manager wants to understand performance of operational metrics to
improve efficiency. You can create a report that visualizes operational metrics across a period
of time to identify areas of improvement.

Report Tutorial: Regional Managers Property Performance
This topic provides an example walkthrough of how a regional manager can design and create
an analysis report to address a business need.

Identify the Data Shown by the Report

A regional manager wants a visualized comparison of property revenue and performance
across all properties in the region. To determine the data to be shown by the report, the
regional manager conceptualizes the information needs and decides that for each property, the
report should include:

• The total room revenue.

• The total number of occupied rooms.
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Identify the Subject Areas

Identify the subject areas that contain the columns and attributes required for the report. In this
example, the Statistics-Managers Report subject area contains every column required for
creating this report.

Add Data Columns to the Report

On the Criteria tab, the regional manager adds the following columns:

• Property Details/Chain Code

• Property Details/Property

• Dates/Business Date Calendar/Year

• Room Details/Occupied Rooms

• Revenue Details/Room Revenue

Add Filters to the Report

On the Criteria tab, the regional manager adds the following filters:

• Chain Code (prompted)

• Year (prompted)

Add Visualizations to the Report

On the Results tab, the regional manager begins adding and configuring the report layout and
style. To set up a line-bar graph to show the Total Room Revenue Comparison with
Occupied Rooms, select the visualization for the line-bar graph to show the Total Room
Revenue Comparison with Occupied Rooms.

Running, Printing, and Exporting Analysis Reports
1. OPERA Reporting and Analytics only shows reports for which you have access.

2. Access the Catalog by clicking the Catalog option on the menu bar and select the My
Folder or Shared Folder (and the underlying sub-folder where applicable) and click on
Open to execute the report.

3. Select or enter the report parameters, and then click OK.

4. To clear the report parameters, click Reset.

5. To print the analysis report, click Print, and then select a printable format.

6. To export the analysis report, click Export, and then select a file or data format.

Editing Existing Analysis Reports
1. On the Criteria tab of an existing report, drag and drop columns from the Subject Area

pane to the Selected Columns pane to add columns to the report and to configure default
sorting and filters. You can double-click a column to add the column to the end of the table.

2. On the Criteria tab, add, edit, and remove filters in the Filters pane.
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3. On the Results tab, preview the appearance and output of the report, and edit the layout of
the report. You can customize the formula in each column, change column labels, and
apply aggregation rules.

4. On the Results tab, you can configure rules for data selection in the Selection Steps pane
to refine the data on which the report works.

5. On the Prompts tab, you can add and configure user input prompts in the Prompts pane to
create a form in which users specify their report parameters. You can also configure the
title, text, and appearance of the prompts form in the Display pane.

Create a New Analysis Report
1. From the Reporting Menu Bar select New/Create > Analysis.

2. Search and Select the Subject Area for your new Analysis Report.

3. To add and configure columns for the report:

a. On the Criteria tab, find the columns you want to add to the report in the Subject Area
pane.

b. Drag and drop the columns to the Selected Columns pane.

c. To configure the sorting order for a column, click the configure icon, select Sort, and
then select the sorting method.

d. To configure filters for a column, click the configure icon, select Filter, and then
configure the filter for the column.

4. To add a filter for a subject area element that is not a column in the report:

a. On the Criteria tab, click the Create a filter for the current Subject Area button in the
Filters pane.

b. Navigate to the subject area element by which you want to filter, and then click OK.

c. Configure the filter settings, and then click OK.

5. To configure the aggregation rule for a column:

a. On the Results tab, click Edit View to open the Layout pane.

b. In the Columns and Measures section, click the configure icon for a column, select
Aggregation Rule, and then select the aggregation rule that corresponds to the
Column Aggregation configuration element.

6. To add and configure prompts for user input when running the report:

a. On the Prompts tab, click the New button.

b. Select the type of prompt you want to add.

c. Configure the prompt, and then click OK.

7. To configure the prompt form:

a. On the Prompts tab, click the Edit button in the Display pane.

b. Configure the form, such as by setting the title and information text to show with the
user input prompts, and then click OK.

8. Click Save to save the report or Click Save As to Save and rename the existing report to
extend the report for further analysis. Reports can be saved in your personal My Folder. To
share a report with other users, save to a folder under the Organization folder in the
Shared Folders.
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Saving directly to the Shared Folder or creation of new folders in the Shared Folders is not
permitted. New folders can be created under the Shared Folders > Organization folder
only.

Scheduled Reports
You use the Agents to schedule your reports. This can be done by creating an Agent from the
New/Create drop down from the Menu Bar or selecting Agent from the Actionable Intelligence
Menu Folder. The Agent created must first be saved and can be used to schedule the report
under the My Folder or the Shared Folders. Visualizations cannot be scheduled at this time.

As a best practice it is recommended that all Agents and the corresponding Analysis be saved
under the Shared Folders directory. Any moving or renaming of the folder structure, or of the
Agent/Analysis may result in agents getting disable and at times results in access issues to the
Agents when trying to re-enable.

You may optionally compress your file output by using the “Compress output prior to delivery”
option on the Output tab of the Schedule Report Job screen. This will produce and distribute
a .zip file into email, SFTP or Object Storage.

Best Practices and Prerequisites For Data Models
The following are recommended best practices for you to follow prior to creating a data model.

• Create a folder specifically for BI Publisher reports. As the number of reports needed may
increase over time, having a specific folder for all BI Publisher related data models,
analysis templates, and reports will ultimately save time and avoid confusion. (Best
Practice Recommendation)

• Create an Analysis folder within the BI Publisher Folder to store all analysis/report
templates. (Best Practice Recommendation)

• Build a new analysis or select an existing analysis to build the data model for BI Publisher.
In this example, the existing Statistics Matrix analysis has been selected. (Prerequisite)

• ▪ Create a copy of the selected analysis and paste the copy in the Analysis folder. Although
it is not a required step, it is recommended to use a copied analysis for BI Publisher for 2
reasons:

1. i. Analysis templates for BI Publisher should not have prompts attached if bursting is
applied.

2. ii. Should the original analysis be modified, it will not affect the BI Publisher. (Best
Practice Recommendation)

Creating a Data Model
1. In the R&A application screen, select the drop down menu for “Create” and click on “Data

Model”.

2. A new “Untitled” screen will open. Select the drop down menu for the “+” sign under the
“Diagram” tab. Click on “Analysis”.

3. A “New Data Set – Analysis” window will open.

a. Enter a Data Set “Name”.

b. Select the “Analysis” used for the Data Set.
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c. Enter “90” seconds for “Time Out”. (Best Practice Recommendation)

4. Click “OK” and return to the “Untitled” screen.

5. Select the “Structure” tab. The screen will default to the “Table View”

6. The “XML Tag Name” column maps the “Data Source” information with the “Display Name”
information. Enter the appropriate attribute names in the “XML Tag Name” column. (XML
Tag Names do not allow space, use the “_” sign instead of space)

7. Click on “Properties” in the “Data Model” menu.

8. In the “XML Output Options” option, uncheck “Include Parameter Tags” box and check the
“Include Empty Tags for Null Elements” box. (Best Practice Recommendation)

9. Return to the created Data Set and select the “Data” tab. Click on “View” and the system
will run through the Data Set to confirm that all the attributes are correctly mapped.

10. Click on “Save As Sample Data”.

11. Select “Save” from the top right corner of the screen. Add “_DM” to indicate the file is a
Data Model. (Best Practice Recommendation)

12. Data Model is now created and saved.

Creating a BI Publisher Report
1. In the R&A application screen, select the drop down menu for “Create” and click on

“Report”.

2. From the pop up screen, select “Use Data Model” and search for the appropriate Data
Model in the “Data Model” box. Click on “Next”.

3. In the “Select Layout” tab:

a. Select “Portrait” or “Landscape”

b. Add “Page Header” and/or “Page Footer”

c. Select the desired layout

4. Click “Next”.

5. In the “Create Table” tab, drag and drop the necessary attributes onto the report screen.

6. Check the “Show Grand Totals Row” if necessary. Click on “Preview Report”

7. A separate tab will open displaying the report. Close tab and return to the report screen.

8. Click “Next”.

9. The “Save Report” tab will appear. User can select to “View Report” or “Customize Report
Layout” and click “Finish”.

10. The report can be viewed or exported in the following formats:

a. Interactive

b. HTML

c. PDF

d. RTF

e. Excel(*.xlsx)

f. PowerPoint(*.pptx)
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Bursting By Email
1. Select the appropriate Data Model and click on “Edit”.

2. Select “Bursting”.

3. Below the “Bursting” heading, click on the “+” sign and a new row will appear.

4. Enter the email address for delivery under the Name column.

5. Select “SQL Query” under the Type Column.

6. Select “Analytics” under the Data Source Column.

7. Under the “Bursting Query | Attachment” heading, users can use the “Split By” drop down
menu to separate reports by categories such as “by property”.

8. Users can also use the “Delivered By” drop down menu to email reports by categories
such as by property.

9. Do not check the “Enable Consolidated Output” and “Group Data by Split Key Values”
check boxes.

10. Copy and paste the template below in the “SQL Query” section.

select DISTINCT

RESORT KEY,

'Arrivals_Report' TEMPLATE,

'RTF' TEMPLATE_FORMAT,

'en-US' LOCALE,

'PDF' OUTPUT_FORMAT,

'Email' DEL_CHANNEL, -- Can be any of the output type part of the Template

'Arrivals_Report - '||Resort||'_'||to_Char(Sysdate-1,'YYYYMMDD') OUTPUT_NAME,

'xxx.xxx@xxx.com' PARAMETER1, -- TO ADDRESS

'yyy.yyy@yyy.com' PARAMETER2, -- CC ADDRESS

'noreply_cds_gbu-analytics@gbua.ocs.oraclecloud.com' PARAMETER3, -- FROM ADDRESS

'Bursting Arrivals Report Sample' PARAMETER4,

'Attached is the output for '||RESORT ||'.csv' PARAMETER5,

'true' PARAMETER6

from RESORT

Once the template is pasted, modify the Query as below:

• RESORT KEY – No need to modify.

• TEMPLATE – The report name that will be used for bursting. The report name can be
retrieved from the Properties menu of the report.

• TEMPLATE_FORMAT – No need to modify. The resulting report will still be delivered in
the format that was specified in report properties.
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• LOCALE – This defaults to the user account’s locale/location setting.

• OUTPUT_FORMAT – The output format of the delivered report such as PDF.

• DEL_CHANNEL – This indicates the delivery channel for the report. In this case, “email” is
used.

• RESORT OUTPUT_NAME – The file name that appears. In this example, the file name
will be “Arrivals_Report – Property Name_System date minus 1 day” in YYYYMMDD
format.

• TO ADDRESS – The Email address/es to which the report will be sent. To enter multiple
email addresses, use the following format: ‘xxx@xxxx.com,yyy@yyyy.com’

• CC ADDRESS – The CC Email address/es. To enter multiple email addresses, use the
following format: ‘xxx@xxxx.com,yyy@yyyy.com’

• FROM ADDRESS – Indicates the email address from which the report will be sent.

• PARAMETER 4 – Indicates the subject line of the email.

• PARAMETER 5 – Indicates the email body.

• PARAMETER 6 – Indicates if the email is secure. Leave this value as “TRUE.”

1. Click on the “Save” icon. Bursting by email is now set up on the Data Model.

2. Return to the “Catalog” screen and select “Edit” on the BIP report to be delivered.

3. Select “Properties” and check the box for “Enable Bursting” in the “General” tab.

4. Click “OK”.

5. Return to the catalog, click on “More” on the BIP report and select “Schedule”.

6. In the “Schedule Report Job” window, select the “Output” tab.

7. Check the “Make Output Public” check box to make report public.

8. Check the “Save Data for Republishing” check box to retain data for republishing.

9. Check the “Compress output prior to delivery” to send report in compressed format.

10. Users can designate outputs and destinations.

11. In the “Schedule” tab, select “Frequency”

a. Once

b. Hourly/Minute

c. Daily

d. Monthly

e. Annually

f. Specific Dates

12. Select “Run Now” or a designated start date and time.

13. In the “Notification” tab, check the “Notify By” check box and enter the recipient email
address. Use “,” to separate multiple email addresses.

a. Check “Report completed” to send notification when report is completed.

b. Check “Report completed with warnings” to send notification when report is completed
with warnings.

c. Check “Report failed” to send notification when report fails to complete.

d. Check “Report skipped” to send notification if report was skipped.
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14. Click “Submit” and enter a “Report Job Name”.

Bursting By FTP
1. Select the appropriate Data Model and click on “Edit”.

2. Select “Bursting”.

3. Below the “Bursting” heading, click on the “+” sign and a new row will appear.

4. Enter SFTP under the Name column.

5. Select “SQL Query” under the Type Column.

6. Select “Analytics” under the Data Source Column.

7. Copy and paste the template below in the “SQL Query” section.

select DISTINCT

RESORT KEY,

'Arrivals_Report’ TEMPLATE,

'RTF' TEMPLATE_FORMAT,

'en-US' LOCALE,

'PDF' OUTPUT_FORMAT,

'FTP' DEL_CHANNEL, -- Can be any of the output types part of the Template

‘REPORT’ OUTPUT_NAME,

'HGBUSFTPProfile-2' PARAMETER1, --sftp server name

'/OCRNA' PARAMETER4, --remote directory

'Arrivals_Report - '||Resort||'_'||to_Char(Sysdate-1,'YYYYMMDD') PARAMETER5,

'true' PARAMETER6

from RESORT

Once the template is pasted, modify the Query as below:

• RESORT KEY – No need to modify.

• TEMPLATE – The report name that will be used for bursting. The report name can be
retrieved from the Properties menu of the report.

• TEMPLATE_FORMAT – No need to modify. The resulting report will still be delivered in
the format that was specified in report properties.

• LOCALE – This defaults to the user account’s locale/location setting.

• OUTPUT_FORMAT – The output format of the delivered report such as PDF.

• DEL_CHANNEL – This indicates the delivery channel for the report. In this case, “FTP” is
used.

• RESORT OUTPUT_NAME – The output name is not used. In this case, leave the line as
“REPORT OUTPUT NAME.” The actual file name will be indicated in Parameter 5.

• PARAMETER 1 – This indicates the FTP server’s name. If the SFTP is set up, you can
find the server’s name under Schedule, Output tab, Add Destination, FTP Server field.
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• PARAMETER 4 – This indicates the remote directory. In this example, the remote directory
is /OCRNA. If the SFTP is set up, you can find the remote directory name in the application
portal menu under Controls, SFTP, Remote Directory field.

• PARAMETER 5 – This indicates the file name. For example, Arrivals_Report - '||
Resort||'_'||to_Char(Sysdate-1,'YYYYMMDD') is used.

• PARAMETER 6 – Indicates if the email is secure. Leave this value as “TRUE.”

1. Click on the “Save” icon. Bursting is now set up on the Data Model.

2. Return to the “Catalog” screen and select “Edit” on the BIP report to be delivered.

3. Select “Properties” and check the box for “Enable Bursting” in the “General” tab.

4. Click “OK”.

5. Return to the catalog, click on “More” on the BIP report and select “Schedule”.

6. In the “Schedule Report Job” window, select the “Output” tab.

7. Check the “Make Output Public” check box to make report public.

8. Check the “Save Data for Republishing” check box to retain data for republishing.

9. Check the “Compress output prior to delivery” to send report in compressed format.

10. Users can designate outputs and destinations.

11. In the “Schedule” tab, select “Frequency”

a. Once

b. Hourly/Minute

c. Daily

d. Monthly

e. Annually

f. Specific Dates

12. Select “Run Now” or a designated start date and time.

13. In the “Notification” tab, check the “Notify By” check box and enter the recipient email
address. Use “,” to separate multiple email addresses.

14. Check “Report completed” to send notification when report is completed.

15. Check “Report completed with warnings” to send notification when report is completed with
warnings.

16. Check “Report failed” to send notification when report fails to complete.

17. Check “Report skipped” to send notification if report was skipped.

18. Click “Submit” and enter a “Report Job Name”.

Bursting for BIP Efolio Report
1. Select the appropriate Data Model and click on “Edit”.

2. Select “Bursting”.

3. Below the “Bursting” heading, click on the “+” sign and a new row will appear.

4. Enter the email address for delivery under the Name column.

5. Select “SQL Query” under the Type Column.
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6. Select “Analytics” under the Data Source Column.

7. For Email Query, copy and paste the template below in the “SQL Query” section.

select DISTINCT

RESORT KEY,

'eFolio_xml_Report' TEMPLATE,

'ETEXT' TEMPLATE_FORMAT,

'en-US' LOCALE,

'TEXT' OUTPUT_FORMAT,

'Email' DEL_CHANNEL, -- Can be any of the output type part of the Template

RESORT OUTPUT_NAME,

'<To Email Address>' PARAMETER1,

'<CC Email Address>' PARAMETER2, -- CC

'noreply_cds_gbu-analytics@gbua.ocs.oraclecloud.com' PARAMETER3, -- FROM ADDRESS

'Bursting Sample' PARAMETER4,

'Attached is the output for '||RESORT PARAMETER5,

'true' PARAMETER6

from RESORT

For FTP Query, copy and paste the template below in the “SQL Query” section.

select DISTINCT

RESORT "KEY"

'eFolio_xml_Report' TEMPLATE

'ETEXT' TEMPLATE_FORMAT

'en-US' LOCALE

'TEXT' OUTPUT_FORMAT

'FTP' DEL_CHANNEL

RESORT OUTPUT_NAME

'<SFTP Server Name>’PARAMETER1 --sftp server name

'<Directory Path>' PARAMETER4 --remote directory

'<ReportName> - '||Resort||'_'||Sysdate||'.xml PARAMETER5 --file name

'True' PARAMETER6

from RESORT

Configuring Burst Reports for Object Storage

Chapter 11
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• After configuring the Publisher data model, as you build your burst query by navigating to
the bursting section, you need to be aware of some of the key parameters to be supplied to
the burst query that are specific to Object Storage.

• Sample Bursting Query for object storage as the delivery channel:

select DISTINCT

RESORT KEY,

'Arrivals_Report’ TEMPLATE,

'RTF' TEMPLATE_FORMAT,

'en-US' LOCALE,

'PDF' OUTPUT_FORMAT,

'OBJECTSTORAGE' DEL_CHANNEL,

'<output_name>' OUTPUT_NAME,

'OS' PARAMETER1,

'<prefix>'PARAMETER2,

'<file_name>' PARAMETER3

from RESORT

Key parameters that are specific to object storage are:

Once the template is pasted, modify the Query as below:

• RESORT KEY – No need to modify.

• TEMPLATE – The report name that will be used for bursting. The report name can be
retrieved from the Properties menu of the report.

• TEMPLATE_FORMAT – No need to modify. The resulting report will still be delivered in
the format that was specified in report properties.

• LOCALE – This defaults to the user account’s locale/location setting.

• OUTPUT_FORMAT – The output format of the delivered report such as PDF.

• DEL_CHANNEL – This indicates the delivery channel for the report. This needs to be
keyed in as OBJECTSTORAGE.

• REPORT OUTPUT_NAME – The output name is not used. In this case, leave the line as
“REPORT OUTPUT NAME.” The actual file name will be indicated in Parameter 3.

• PARAMETER 1 – Use OS as the parameter value for this, because this is the
preconfigured server name. The value for this should be kept as OS and should not be
changed.

• PARAMETER 2 – Prefix under the object storage bucket where the file will be uploaded.
The prefix should not start or end with a / character; for example ris/outgoing is a possible
prefix to use.

• PARAMETER 3 – This indicates the file name. File name. The file will be created under
the prefix; For example, shared/chainname/Arrivals_Report - '||Resort||'_'||
to_Char(Sysdate-1,'YYYYMMDD')|| '.pdf' is used.
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Scheduling BIP Report
Enable Bursting for the Report to be scheduled.

1. In the BIP Report Properties, select Enable Bursting and from the drop down, select the
Bursting Query defined in the underlying Data Model.

2. Select the BIP report and schedule it.

3. On the Schedule tab, select the frequency and submit the job.

Notes
The following oracle document can be used for further information on Bursting in OBIEE.
Although this document is for the older version of OBIEE, it holds good for the current version
of the OBIEE used in R&A.

https://docs.oracle.com/cd/E21764_01/bi.1111/e18862/T527073T555155.htm

Viewing and Editing Analysis Reports in Microsoft Office
You can use Oracle Smart View for Office to access analysis reports and to work with
Reporting and Analytics data from within a Microsoft Office application.

1. Log into OPERA Reporting and Analytics, using the URL provided by your manager.

2. Open the Reporting and Dashboard tile on your Home page.

3. From the reporting and dashboard page, select the Download Desktop Tools dropdown list
and select the Smart View for MS Office option.

4. Select the Download Smart View for Office option, then click Download Now.

5. Accept the Oracle License Agreement and choose Download. You may be prompted to log
in with an Oracle account if you are not already logged in.

6. After file downloads, extract all files, and run the smartview.exe as an administrator.

7. After the client installs completely, start your Microsoft Office application then open the
Smart View tab.

8. Click Panel > Private Connection and click the drop-down menu next to the server selection
option. Select the Create new connection option.

9. Click Oracle BI EE and copy/paste the Smart View URL located in the External Reporting
Links section of your Controls page.

10. Click Finish

You can now log into R&A and save the private connection. Please refer to the Oracle Smart
View for Office documentation for instructions and information on use.
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Dashboards
OPERA Reporting and Analytics dashboards provide a collection of data and visualizations
designed to give you an overview of information on one screen and to allow you to drill down
for more detailed information.

Note:

Online Help opens if you access Help when creating or editing analysis reports or when
working with dashboards. The online Help may describe functionality not available in OPERA
R&A.

Available Dashboards

You can add and view the following dashboards:

Property Overview

This dashboard shows key revenue metrics across all properties or select properties filtered by
business date. This includes:

• Summary metrics such as total revenue, room revenue, average daily rate, and revenue
per available room.

• A matrix of available and occupied rooms per room type for each property.

• Visualizations for the following statistics for the last closed business date:

– Room Statistics

– Arrival vs Departure Rooms

– Group vs Transient Rooms

You can filter the dashboard by properties or business date.

Financials

This dashboard provides visualizations of revenue by market and of payments. The dashboard
also contains a summary of ledger activity details. You can filter the dashboard by property,
business date, market code, transaction code group, and transaction code sub-group.

Reservations

This dashboard provides snapshot view of key reservation metrics, including 7-day pickup %
and 30-day pickup % for rooms, revenue, and average daily rates (ADR). The dashboard also
shows visualizations comparing totals to the previous month and to the previous week. You
can filter the dashboard by property.
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12
Performance Monitoring

The following performance recommendations are designed to assist administrators in tuning
their report job schedules to run optimally based upon the available resources.

Table 12-1    Limits Querying Data (Data Visualizations, Classic Analyses and
Dashboards)

Which compute size do you have? Limits when querying data for visualizations,
analyses, and dashboards

Max input rows returned from any data source
query

Small 2,000,000

Medium 2,000,000

Large 4,000,000

When you query a data source for data visualizations or Classic analyses and dashboards, the
compute size determines the maximum number of rows that are returned from the data source.

Table 12-2    Limits Displaying Data (Data Visualization, Classic Analyses and
Dashboards)

Which compute size do you have? Limits when displaying data in visualizations,
analyses, and dashboards

Max summarized rows returned from any data
source query

Small 500,000

Medium 500,000

Large 1,000,000

When you display data in data visualizations or Classic analyses and dashboards, the compute
size determines the maximum number of summarized rows returned from the data source that
are displayed.

Table 12-3    Limits Exporting Data (Data Visualizations)

Which compute size do you have? Limits when exporting data from data
visualizations to CSV file

Small 2,000,000

Medium 2,000,000

Large 4,000,000

When you export data from a data visualization, the compute size determines the maximum
number of rows you can export to a CSV file.
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Table 12-4    Limits Exporting Data (Classic Analyses and Dashboards)

Which compute size do you
have?

Limits when exporting data from analyses and dashboards

Max rows exported to
unformatted reports

Max rows exported to
formatted reports

Small 2,000,000 200,000

Medium 2,000,000 200,000

Large 4,000,000 400,000

When you export data from analyses and dashboards, the compute size determines the
maximum number of rows you can export. There are different limits for formatted data and
unformatted data.

• Unformatted data limits: formats such as CSV, Excel, XML, and Tab Delimited.

• Formatted data limits: formats such as PDF, Excel, Powerpoint, and Web Archive/HTML.

Note: When two pivot views are laid out side by side in a union the formatted export limit will be
20,000 rows.

Table 12-5    Limits Delivering by Email (Classic Analyses and Dashboards)

Which compute size do you
have?

Limits when delivering analyses and dashboards by email

Max rows in unformatted reports
delivered by email

Max rows in formatted reports
delivered by email

Small 200,000 50,000

Medium 200,000 50,000

Large 300,000 100,000

If you plan to send analyses and dashboards by email, the compute size determines the
maximum number of rows you can deliver in a single email. There are different limits for
delivering formatted data and unformatted data.

• Unformatted data limits: formats such as CSV, Excel, XML, and Tab Delimited.

• Formatted data limits: formats such as PDF, Excel, Powerpoint, and Web Archive/HTML.

Table 12-6    Data Size Limits (Classic Pixel-perfect Reports)

Which compute
size do you
have?

Report data size limits when generating pixel-perfect reports

Max data size
for online
reports

Max data size for
offline (scheduled)
reports

Max data size for
bursting reports

Max data size for
data generation

Small 500MB 2GB 4GB 2GB

Medium 500MB 2GB 4GB 2GB

Large 500MB 4GB 8GB 4GB

If you plan to generate pixel-perfect reports, the compute size determines several limits
associated with report generation.
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Table 12-7    Processing Limits (Classic Pixel-perfect Reports)

Which
compute size
do you have?

Data model and report processing limits when generating pixel-perfect reports

SQL Query
timeout for
scheduled
reports
(seconds)

Max rows for
CSV output

Max number
of in-memory
rows in XPT
layout

Max number of
concurrent
scheduled jobs

Max number of
concurrent
online reports

Small 1,800 4,000,000 200,000 4 46

Medium 1,800 4,000,000 200,000 4 96

Large 3,600 6,000,000 300,000 10 480

If you plan to generate pixel-perfect reports, the compute size determines several limits
associated with report processing.
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13
Best Practices

Main Section Sub Section Best Practice
Description

Scenarios

Application Portal

Controls Central Currency Activate the Central
Currency function only
if necessary, as once
the feature is
activated, it cannot be
reversed or
deactivated.

1. If all properties and
the Corporate Office
use the same currency,
do NOT activate
feature.
2. If all properties use
the same currency but
the Corporate Office
uses a different
currency, activate
feature.
3. If all/some
properties use
different currencies
and the Corporate
Office needs reports
that utilize a single
currency, activate
feature.

Controls Object Storage Administrators should
regenerate the APP
secret(password)
annually as a standard
procedure.

Controls SFTP When utilizing SFTP,
enable resend
functionality.

When using bursting
for BIP reports,
enabling the resend
functionality will
provide redundancy in
report delivery in case
it fails for unforeseen
reasons.

Controls Service Account Always create a service
account and associate
in the application
portal.

SFTP resend
functionalities require
use of a Service
Account and if the
service account is
absent, SFTP resend
function cannot be
enabled.
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Groups Custom Groups Create custom groups
to limit access to
specific application
and reporting
functionality based
upon the user’s role in
the organization.

Users such as shift
supervisors who are
permitted to run
reports, but not
author/edit report
should have a custom
group that will restrict
their user tasks to only
allow consumption of
existing reports.

Groups Set Group Tasks Only assign
administration tasks
that are needed to
support the groups
role in the application
portal.

Most user groups
should not have access
to the Edit Users
privilege. The access
should be limited to
related roles such as
Director of IT.

Groups Set Group Tasks Only assign reporting
tasks that are needed
to support the groups
role in the reporting
module.

Users such as
supervisors may only
need consumption
privilege on reports
and users such as
department managers
may need ability to
author reports.

Users Administration Always configure
additional users as
OIM Administrators to
allow for group and
user creation in case of
administrator absence
or departure and to
avoid interruption in
operations.

Upon initial access to
R&A, designate
multiple roles such as
the Director of IT and
the Controller as OIM
Administrators.

Users Define Property Level
Access

Although it is easier to
grant access to all
properties to a user,
for security reasons,
make sure to only
assign levels,
properties, chains to
users who should be
accessing the data.

Employees who work
for property A should
not be able to access
guest or records in
property B or C.
Therefore, they should
only be granted access
at the property level.
On the other hand, a
Corporate Revenue
Manager will need
access to all properties
and therefore should
be granted access at
the enterprise level.
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Central Reporting
Conversion

Monitoring Periodically review
each of the reporting
item types for
unaligned reporting
items in the Central
Reporting Conversion
Screen. Failure to align
all reporting items
may result in
discrepancies in report
data when Central
conversion fields are
utilized in reporting.

For example, if a new
property is added to
the enterprise that
already has aligned
central market codes,
and there are market
codes in the new
property that do not
align with the central
codes, they will appear
in the Unaligned
Reporting Items
column in the Central
Reporting Conversion
screen.

R&A Application

My Account Preferences There is an option to
start in the Criteria tab
or Results tab when
editing the report. In
Analysis Editor, choose
Full Editor and select
Start on Criteria tab
when editing Analysis.
This allows the user to
immediately start
editing the report in
the criteria tab instead
of having to wait for
the report to run in
results tab first before
being able to switch to
the criteria tab.

Creating/Editing
Analytics

Prompts When creating
prompts, choose a
default selection to
minimize report run
time. (Edit Prompt -
Options - Default
Selection)

For reports such as the
Pace report where a
certain date range is
usually set, create a
default selection in the
prompt for a set date
range.

Creating/Editing
Analytics

Filters When possible, create
filters to limit results
which will help
minimize report run
time.

In the Reservations
Report, users can
create a property filter,
a Reservation Status
filter and a Room Type
filter so the report only
displays Property A
with reservations that
are in Reserved status,
and it will exclude
pseudo room types.
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Creating/Editing
Analytics

Subject Area When creating a
report/analysis, do not
add Subject Area to the
current Subject Area
as the action is not
supported by R&A. In
many cases, it will lead
to performance issues
or failure to execute
reports.

Instead of combining
subject areas in an
analysis/report which
is not supported by
R&A, users can create
dashboards that
includes reports from
multiple subject areas.
The Dashboard can
then be exported and
scheduled for delivery.

Creating/Editing
Analytics

Sharing Analysis/
Visualizer Reports

Save reports in Shared
Folder to avoid access
issues. No one will
have access to edit,
delete reports, data
models or agents that
are saved in the user's
My Folder especially if
the user no longer
works for the
company.

If a report creator such
as the Director of
Revenue has created
pace report,
reservations report
and 90 Day Forecast
report and only saved
them in My Folder,
only the Director of
Revenue will have
access to run or
schedule those reports.
If the director no
longer works for the
property, the hotel
staff will have to
create all those reports
from scratch.

Creating/Editing
Analytics

Filtering Dimension/
Measure Attributes

Keep in mind that
Dimension attributes
will provide a list of
available values
whereas Measure
attributes will require
user to input a value.

For example, when
filtering “Reservation
Status”(Dimension
Attribute), user can
select the desired
values from a
dropdown list
provided such as
“Checked in”, “Checked
out” or “ No Show”;
when filtering
“Amount”(Measure
Attribute), user will
need to enter a value
such as “100”.

Creating/Editing
Analytics

Altering Template
Reports

If template reports are
altered for specific
needs of the user, be
sure to save the altered
version as a separate
new report as the
altered versions will
be saved over in the
next release.
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Creating/Editing
Analytics

Business Date Range
in Statistics History
and Forecast Subject
Area

Ensure to specify a
business date range
when creating a report
in the subject area.
Without a date range
specified, the system
will automatically
display a row for every
day between the past 3
years and the next 10
years from current
date, which will
severely affect
performance.

Creating/Editing
Analytics

Selecting Attributes It is recommended that
when using the search
option to find an
attribute, attention is
paid to which folder/
subfolder the attribute
is located in order to
pull the data correctly
and most efficiently.

The search for "First
Name" in the Bookings
Reservation SA will
result in 2 attributes. If
we hover the cursor
over the attributes, it
will indicate that 1 is
the reservation guest's
first name and the
other is the
accompanying guest's
first name.

Agent Report Frequency If multiple re-runs of a
report are necessary,
set the re-runs to be at
least 15 minutes apart.
For larger reports 30
minutes or more apart
to minimize
performance issues
such as extended run
time.

Examples of big
reports are Pace
Reports, Transaction
Reports, or reports that
have a large date range
with multiple daily
results such as 90 days
reservations forecast
with multiple
attributes. Examples of
smaller reports are
Arrival Reports,
Housekeeping Reports
and Credit Reports.
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Agent Scheduling multiple
Reports

Scatter the scheduled
jobs to distribute the
load uniformly over a
period of time. Do not
clutter all jobs in a
short period of time.
User should run
critical scheduled jobs
during off-hours to
avoid performance
issues.

If there are 10 big
reports that needs to
be scheduled. Best
Practice would be to
start their deliveries
after peak hours, for
example after 5pm.
And scatter the
delivery time with 1-
hour differences to
minimize performance
issues. Examples of big
reports are Pace
Reports, Transaction
Reports, or reports that
have a large date range
with multiple daily
results such as 90 days
reservations forecast
with multiple
attributes.

Agent Scheduling Reports If the report is
renamed, moved or
deleted, make sure to
pause or cancel the
agent/schedule.
Otherwise the system
will continue to send
notification of failure.

BI Publisher Data Model — Data
Sets

Be precise with needed
data by selecting only
columns needed and
use “where” clause
and bind parameters
whenever possible to
restrict returned data
more precisely

Instead of using query:
SELECT * FROM
EMPLOYEES;
use SELECT
DEPARTMENT_ID,
DEPARTMENT_NAME
FROM EMPLOYEES
WHERE
DEPARTMENT_ID IN
(:P_DEPT_ID)
This will reduce the
amount of data
returned.

BI Publisher Data Model — Data
Sets

Use shorter column
names to minimize the
XML file size, therefore
shortening I/O
processing time. This
will enhance report
efficiency.

Shorten
“DEPARTMENT_IDENT
IFICATION” to
“DEP_ID” or
“RESERVATION_TYPE”
to “RES_TYPE”

BI Publisher Data Model — Data
Sets

The number of
columns/attributes
selected in SQL queries
should not exceed 100.
Large number of
columns will impact
report performance.
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BI Publisher Data Model — Data
Sets

Sorting should be done
in the SQL, not during
report formatting.
Sorting of data is
highly recommended
to be done at the time
of data extraction and
we should avoid
sorting during report
formatting to improve
performance.

Example:
select resort,
confirmation_no,
resv_name_id,
begin_date, end_date
from reservation name
where resv_status =
'RESERVED' order by
begin_date

BI Publisher Data Model —
Parameters

Binding a large
number of parameter
values is inefficient
and may cause
performance issues.
Limit the List of
Values(LOV) based on
SQL queries to 1000
rows.

When creating a list of
value populate the
number of values
based on the required
amount of data
elements returned.

BI Publisher Data Model —
Parameters

When creating a Menu
type parameter, if the
list of values may
contain multiple
values, ensure that if
you enable both the
"Multiple Selection"
and "Can Select All"
options, then also
select NULL value
passed to limit the
values that are passed.

When creating
parameter ensure to
select proper flags to
make the report more
efficient.

BI Publisher Report Make sure that Data
Caching is not enabled
in Report Properties-
Caching. The Enable
Data Caching box
should be unchecked
to ensure up to date
data extraction.

BI Publisher Report Bursting If bursting is
configured for reports,
make sure to enable
SFTP resend function
in the application
portal.

When using bursting
for BIP reports,
enabling the resend
functionality will
provide redundancy in
report delivery in case
it fails for unforeseen
reasons.

BI Publisher Report Bursting When using the
bursting function for
SFTP, limit number of
files for each report to
avoid performance
issues. It is
recommended to
ideally limit the
number of files to 150.
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14
SFTP Service Configuration

This chapter contains information for using these document templates.

Required Information
For Oracle to configure a connection from the data center to your SFTP service, the following
information must be provided.

• SFTP Service Profile Name

This value allows you to distinguish between SFTP services when more than one SFTP
profile used for distribution is defined. This name must be comprised of all capital letters
with no spaces or special characters and a maximum of 14 characters. An underscore is
acceptable.

• SFTP Service IP / Host Name

The IP address of the SFTP service is the preferred means of connecting. Hostnames, if
provided, need to resolve to the service endpoint.

• SFTP Service Port

Port number on the IP/ Host to which the delivery service connects.

• Remote Directory

A defined directory to which the SFTP service will send files by default. The actual remote
directory can be defined with each job request. Use of special characters other than an
underscore are not permitted. Please ensure that the folder is created on the service and
the user has proper permissions to access/write to the directory.

Open an SR requesting SFTP configuration in your R&A instance. The process typically takes
10 to 14 business days to open the connection in the data center after the information is
received. While awaiting this process, please review the next sections on Ciphers and Allowed
IPs to prevent any delays.

After your request is processed, the SFTP profiles show on your Reporting and Analytics
Application Portal under the Controls page. Follow the SFTP Configuration in this User Guide
for defining default credentials for SFTP Profile delivery.

Supported Cipher Suites
Oracle BI Publisher supports the following cipher suites for SFTP delivery:

• 3des-cbc

• blowfish-cbc

• aes128-cbc

• aes128-ctr
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• aes192-ctr

• aes256-ctr

Key Exchange Methods
• diffie-hellman-group1-sha1

• diffie-hellman-group14-sha1

• diffie-hellman-group-exchange-sha1

• diffie-hellman-group-exchange-sha256

Public Key Algorithms
Oracle BI Publisher supports the following public key algorithms:

• ssh-dss

• ssh-rsa

Note:

Blob storage SFTP configured with SSH RSA private keys is not supported by Oracle
BI. Blob storage must be configured to use credential based authorization at this
time. (i.e., companyname.blob.core.windows.net) https://docs.oracle.com/en/cloud/
saas/otbi/otbi-pub-admin/ssh-options-sftp.html

Allowed IPs
To ensure that file delivery is received, please allow the following IP addresses based upon
your OPERA Reporting and Analytics region:

Asia Pacific (SYD)

– 192.29.145.52

– 192.29.144.19

– 192.29.144.238

– 192.29.145.209

– 192.29.145.212

– 192.29.149.217

Bombay (BOM)

– 192.29.163.179

– 192.29.49.26

– 192.29.165.220
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– 192.29.163.1

– 192.29.161.32

– 192.29.166.249

Europe, Middle East and Africa (FRA)

– 130.61.8.226

– 130.61.9.164

– 130.61.13.224

– 130.61.15.8

– 130.61.64.168

– 130.61.65.155

Jeddah (JED)

– 192.29.226.137

– 192.29.227.99

– 192.29.224.186

– 192.29.225.170

– 192.29.227.164

– 192.29.225.242

Singapore (SIN)

– 129.148.179.106

– 129.148.179.88

– 129.148.177.241

– 129.148.178.234

– 129.148.178.235

– 129.148.176.25

The Americas (IAD)

– 129.213.11.191

– 129.213.14.79

– 129.213.67.18

– 129.213.72.220

– 129.213.75.248

– 129.213.76.27
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15
Object Storage

This chapter explains how to configure file delivery to Object Storage (OS) and how to manage
files (access, list) via API.

Prerequisites
This chapter contains instructions on prerequisites to utilize Object Storage (OS) functionality
with OPERA Reporting and Analytics (R&A).

• Oracle Analytics Server

• Postman

Oracle Analytics Server

Object Storage was introduced as part of Oracle Analytics Server (OAS) as an alternate way of
storing/delivering data. Currently, Oracle Hospitality is rolling out all new customers with OAS
making Object Storage (OS) available for BI Publisher report delivery. Many existing customers
were installed with Oracle Business Intelligence Enterprise Edition (OBIEE) which did not offer
OS as a feature.

To continue with use of Object Storage, your environment must be using OAS. To confirm
whether you are using OAS or OBIEE, use the following step.

1. From your R&A console, open Reports and Dashboards.

If your R&A page has a Help > Oracle Analytics option, then you are on OAS and can
continue.

If your R&A page has a Help > About Oracle BI EE option, then you are on OBIEE, and
further instruction on OBIEE to OAS migration will become available later.

Postman

Postman is an Application Programming Interface (API) platform for building and using APIs.

To download and install the Postman app, connect to https://www.postman.com/downloads/
and follow the instructions to install and register an account.

File Delivery

Send to Object Storage

This section contains instructions for sending a BI Publisher report to Object Storage (OS).

1. From your Oracle Analytics Server (OAS) console, open Catalog. Locate the BI Publisher
Report you wish to schedule for distribution to OS.

2. From the BI Publisher report, select More > Schedule.

3. Under Schedule Report Job, click the Output tab .
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4. Under Destination > Destination Type, select Object Storage and click Add Destination.

5. This will add the Object Storage output to the page.

6. Under Object Storage, you will need to define the following:

a. Prefix

The Prefix will define the bucket in OS where the object will be stored. Use of special
characters or spaces are not permitted and will prevent retrieval of the object through
PAR URL. Underscores, hyphens, and forward slashes are permitted, Ex:
OPERA_RA/2025-01-01.

b. File Name

The File Name defines the path and file name of the object in the bucket.

NOTE: Prefix and file names are case-sensitive.

For additional information on Object Storage, visit https://docs.oracle.com/en-us/iaas/
Content/Object/home.htm

7. Set the Prefix and File Name for the object and click the Schedule tab.

8. Under the Schedule tab, define the frequency in which to schedule the job.

9. Click the Submit button.

10. Specify the Report Job Name and click OK to schedule.

Generate PAR URL
• Import Postman Collections

• Set Environment Variables

• Generate Token

• Generate PAR URL

Import Postman Files

This section contains instructions for importing the preconfigured Postman collection and
environment for OS into your Postman instance.

1. Navigate tohttps://github.com/oracle/hospitality-api-docs/tree/main/postman-collections/
reporting-and-analytics.

2. Download the Collection file by highlighting the
R&A_ObjectStorage_ParURL.postman_collection.json file in GitHub, then selecting the
More Options > Download option. Save to your local machine.

3. Download the Environment file by highlighting the
R&A_PARVariables.postman_environment.json file in GitHub, then selecting the More
Options > Download option. Save to your local machine.

4. To import the Collection from Postman, select Collections and click the Import option.

5. Select the R&A_ObjectStorage_ParURL.postman_collection.json file from your local
machine using the Postman application to import the Collection.

6. To import the Environment, from Postman, select Environments and click the Import
option.

7. Select the R&A_PARVariables.postman_environment.json file from your local machine
using the Postman application to import the Environment.
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Set Environment Variables

This section contains instructions for defining each of the environment variables in your
Postman instance.

From the Environment section of Postman, click R&A_PARVariables to expose all the required
environment variables.

IDCSHostName

The IDCSHostName variable represents the URL path to your identity management host. This
value will be available from your application logon page in the browser address bar.

Copy your R&A URL up to ".com" and update it to the Current column under the
IDCSHostName variable.

APPId

The APPId variable will be unique to your application instance and can be found under the
Controls > File Delivery > Object Storage tab in the Application Portal.

Copy the AppID value in the portal to the Current column under the APPID variable.

APPSecret

The APPSecret will also be unique to your application instance and can be found under the
Controls > File Delivery > Object Storage tab in the Application Portal. Click the Show button
to expose the secret.

Copy the AppSecret value in the portal to the Current column under the APPSecret variable.

TenantID

The TenantID variable will also be unique to your application instance and can be found under
the User > About in the Application Portal.

Copy the TenantID value in the portal to the Current column under the TenantID variable.

Token

The Token variable can be automatically populated to the environment variables by executing
the GetToken API under Collection now that the first fours environment variables have been
defined.

1. From Postman, select the Collection option.

2. In the Environment list, pin the R&A_PARVariables environment.

3. From Collections, select the GetToken post command.

4. Click Send to retrieve the token and automatically populate to the current value in the
Environment variables.

PortalEndPoint

The PortalEndPoint variable defines which environment you are currently attempting to utilize
(Production or UAT). Use one of the following values depending upon the source of the object
to populate the Current PortalEndPoint:

• PROD:https://portal.ohra.oraclehospitality.ocs.oraclecloud.com/

• UAT:https://uat.ohra.oraclehospitality.ocs.oraclecloud.com/

Prefix

Chapter 15
Generate PAR URL

15-3

https://portal.ohra.oraclehospitality.ocs.oraclecloud.com/
https://uat.ohra.oraclehospitality.ocs.oraclecloud.com/


The Prefix variable will depend upon the Prefix value used when generating the BIPublisher
report. Use the Prefix for the report and update the Current Prefix value.

FileName

The FileName variable will depend upon the file name value used when generating the
BIPublisher report. Use the FileName for the report and update the Current FileName value.

MinutesToExpire

The MinutesToExpire variable will default to 15 minutes in which the PAR URL that is
generated is valid for use. Change the Current value to the number of minutes you wish to
allow for the URL to be active for the end user.

Generate PAR URL

This section contains instructions for generating a PAR URL for an object.

1. From Collections, select the Generate PAR URL post command.

2. Click Send to generate the PAR URL in the response tab of Postman.

3. Copy and distribute this URL to allow access to the object.

Additional APIs
• Generate Folder PAR URL

• All Created PAR URL

• All Expired PAR URL

Generate Folder PAR URL

This API provides you with a listing of generated Objects available to access from a PAR URL.

1. From Collections, select the Generate Folder PAR URL post command.

2. Click Send to generate the Folder PAR URL in the response tab of Postman.

3. Copy and access this URL in a browser to view the list of available objects.

File listing within a folder is limited to 1,000 rows. When additional rows are available, the
nextStartWith will appear with the next file in the listing.

Append the PARURL with ?Start= value from nextStartWith and run. This will return the next
1,000 files. Continue to append the URL with ?Start= until you have reached the end of the list.

If additional guidance is required to use the ListObject, refer to https://docs.oracle.com/en-us/
iaas/api/#/en/objectstorage/20160918/Object/ListObjects

All Created PAR URL

This API provides you with a listing of generated PAR URLs and the current status.

1. From Collections, select the All Created PAR URL get command.

2. Click Send to generate the list in the response tab of Postman.

3. Review the response tab.

All Expired PAR URL

This API provides you with a listing of expired PAR URLs.
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1. From Collections, select the All expired PAR URL get command.

2. Click Send to generate the list in the response tab of Postman.

3. Review the response tab.
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A
Appendix

See below information for current permissions managed through the Group configuration.

Administration Tasks

Category User Task Description

Application Portal

View Portal Allows access to Application Portal

Open Reporting Allows access to Reporting link and tile in
Application Portal

Open Data Analyzer Allows access to Reporting Data Analyzer link and
tile in Application Portal

Groups Portlet

View Group Allows access to the Groups Portlet

Edit Group Allows ability to edit Group

Users Portlet

View Users Allows access to the Users Portlet

Edit Users Allows ability to edit User

Reporting Hierarchy Portlet

View Hierarchy Allows access to the Reporting Hierarchy Portlet

Create Reporting Level Allows ability to Create a Reporting Level in the
Reporting Hierarchy

Edit Reporting Level Allows ability to Edit a Reporting Level in the
Reporting Hierarchy

Delete Reporting Level Allows ability to Delete a Reporting Level from the
Reporting Hierarchy

Central Reporting Conversion Portlet

View Reporting Conversion Allows access to the Reporting Conversion Portlet

Create Enterprise Reporting
Item

Allows ability to Add an Enterprise Reporting Item
in Reporting Conversion

Edit Enterprise Reporting
Item

Allows ability to Edit an Enterprise Reporting Item
in Reporting Conversion

Delete Enterprise Reporting
Item

Allows ability to Delete an Enterprise Reporting
Item from Reporting Conversion

Central Currency Conversion Portlet

View Central Currency
Conversion

Allows access to the Currency Conversion Portlet

Create Central Currency
Rule

Allows ability to Add a Conversion Rule in
Currency Conversion
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Category User Task Description

Edit Currency Conversion
Rule

Allows ability to Edit a Conversion Rule in
Currency Conversion

Controls Portlet

View Controls Allows access to the Settings Portlet

Enable/Set Central
Currency

Allows ability to Enable Central Currency
Reporting and Define Central Currency

Enable Tenant Upgrade
Time

Allows user to specify the upgrade time
preference

View Tenant Upgrade/
Update Notifications

Enables on-screen notification of scheduled
Upgrade/Update

Tiles

Reporting Hierarchy Enables the Reporting Hierarchy Tile on the Home
page

Groups Enables the Groups Tile on the Home Page

Users Enables the Users Tile on the Home Page

Application Change Log Enables Application Change Log tile on the Home
Page

Currency Conversion Enables Currency Rules tile on the Home Page

Fiscal Reporting

View Fiscal Periods Allows access to the Fiscal Period Reporting
portlet

Create Fiscal Year Allows ability to create a fiscal year

Edit Fiscal Year Allows ability to edit an existing fiscal year

Delete Fiscal Year Allows ability to delete a fiscal year

Application Change Log

View Application Change
Log

Allows ability to search and export application
change log records

Reporting Tasks

Category User Task Description

Report Consumer

View Reports and
Dashboards

Allows access to view Seeded/Shared Reports and
Dashboards

Report Author

Author Reports and
Dashboards

Allows ability to create, edit and delete a Reports
and Dashboards

Data Privacy

Include Personal Information Exposes Personal Information on any Reports/
Dashboards

Sensitive Personal
Information

Exposes Sensitive Personal Information on any
Reports/Dashboards

Subject Areas
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Category User Task Description

Accounts Receivable Allows access to Accounts Receivable Subject
Areas

Blocks Allows access to Blocks Subject Areas

Changes Allows access to Change Logs Subject Areas

Configuration Allows access to Configuration Subject Areas

Financials Allows access to Financials Subject Areas

Housekeeping Allows access to Housekeeping Management
Subject Areas

Profiles – Accounts Allows access to Profiles – Account Subject Areas

Profiles – Contacts Allows access to Profiles – Contacts Subject Areas

Profiles – Individuals Allows access to Profiles – Individuals Subject
Areas

Profiles – Other Allows access to Profiles – Other Subject Areas

Property Allows access to Property Subject Areas

Rates Allows access to Rates Subject Areas

Reservations Allows access to Reservations Subject Areas

Revenues Allows access to Revenue Subject Areas

Rooms Management Allows access to Rooms Management Subject
Areas

Sales and Catering Allows access to Sales & Catering Subject Areas

Statistics – Forecast Allows access to Statistics – Forecast Subject Areas

Statistics – Manager Allows access to Statistics – Manager Subject Areas

Statistics – Reservations Allows access to Statistics - Reservations Subject
Areas

Enhancement Requests
Looking to submit a feature enhancement? From https://iccp.custhelp.com/, create a Support
Request under the OPERA Reporting and Analytics solution. Be sure to provide details of your
request as well as the contact information of the person to discuss any additional questions
about the request should they arise from our Product and Development Teams.
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